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1. Uvod

Zadatak ovog zavr$nog rada bio je programski ostvariti virtualnu tipkovnicu pod Android
operacijskim sustavom koja ¢e emulirati klasi¢ne numeri¢ke tipkovnice na starijim
mobilnim aparatima. Android operacijski sustav danas koriste mnogi pametni telefoni te
razvoj aplikacija za navedeni operacijski sustav je jednostavan i besplatan. Za izradu
aplikacije, odnosno virtualne tipkovnice, koristi se Eclipse IDE te programski jezik Java.
Dodak koji se koristi za razvoj aplikacija za Android operacijski sustav je Android SDK te
ADT za Eclipse. U odredenom poglavlju objasnit ¢u naéin instalacije i upotrebu

navedenog razvojnog sustava sa svim potrebnim dodacima.

Motivacija ovog rada lezi u tome da je osnovna virtualna "qwerty" tpikovnica koju koriste
mobilni uredaji s Android operacijskim sustavom nepriklada i neprecizna zbog nedovoljne
rezolucije detekcije dodira ekrana osjetljivog na dodir. Uz funkcionalnost numericke
tipkovnice, navedena virtualna tipkovnica zadrZzat ¢e pojedine funkcionalnosti standardne

Android tipkovnice.

Krajnji cilj je razviti tipkovnicu koja najvise odgovara korisniku koriste¢i se spojem

modernih i starijih tipkovnica.



2. Opis razvojnog sustava za mobilne aplikacije

2.1. Eclipse

Eclipse je besplatno visejezi¢no okruzenje za razvoj programa (engl.software development
environment). U sebi sadrzi IDE te niz raznih dodataka koji sluze za razvoj aplikacija u
razli¢itim programskim jezicima. Najcesce koriSten programski jezik u Eclipse-u je Java,

ali je moguce i programiranje u ostalim programskim jezicima:

e C/C++

e Ruby

e Phyton
o Perl

e PHP

e COBOL

Za svaki programski jezik koristi se razliciti IDE, tako se za razvoj Java aplikacija koristi

Eclipse JDT, a za C/C++ programe Kkoristi Eclipse CDT.

2.2. Android SDK i ADT

Prije razvoja Android aplikacija u potrebno je postaviti dodatak Android SDK u Eclipse.
Android SDK nije potpuno razvojno okruzenje - sadrzi samo bitne SDK alate, koji nam
sluze za preuzimanje ostalih SDK komponenata. Android SDK je skupina alata koji

omogucuju stvaranje aplikacija za Android operacijski sustav.

Eclipse ne sadrzi dovoljno alata za razvoj aplikacija za Android operacijski sustav.
Android nudi posebni dodatak za Eclipse IDE, Android ADT, koji omogucuje i takoder
zantno olakSava razvoj Android aplikacija. Android ADT proSiruje moguénosti Eclipse-a,
omogucuje jednostavno postavljanje Android projekata i dizajniranje korisnickog sucelja.
Po zavrSetku projekta Android ADT omogucuje stvaranje .apk datoteka koje sluze za

distribuciju razvijene aplikacije.



Android ADT se preuzima na sljede¢i nacin: Help > Install New Software > Add > ...

Navedene alate je potrebno nazvati te preuzeti sa sljedece stranice (navedeni link se navodi

unutar URL polja): https://dl-ssl.google.com/android/eclipse

Koriste¢i Android SDK and AVD Manager (Slika 2.1) preuzimamo potrebne komponente i

alate za naSe razvojno okruZenje. Pristupamo mu na sljedeci nacin:

e U Eclipse-u izaberemo padaju¢i izbornik Window > Android SDK and AVD

Manager
e iz Windows-a pokrenemo SDK Manager.exe datoteku

e U Linux-u preko terminala otvorimo tools/ direktorij unutar Android SDK te zatim

izvr§imo naredbu android

Virnual devices SDK Location: C:\sdk

Installed packages
Available package Packages available for download

Settings + |1 3 Android Repository
About i Android SDK Platform-tools, revision 2
~2 Documentation for Android SDK, API 9, revision 2
i+ SDK Platform Android 2.3.1, AP1 9, revision 2
+ SDK Platform Android 2.2, AP1 8, revision 2
v SDK Platform Android 2.1, AP1 7, revision 2
SDK Platform Android 1.6, AP1 4, revision 3
# SDK Platform Android 1.5, AP1 3, revision 4
& Samples for SDKAP1 9, revision 1
& Samples for SDK API 8, revision 1
& Samples for SDKAP1 7, revision 1
«+ [ # Third party Add-ons
@ Googie Inc. add-ons (di-ssl.google.com)
@ Samsung Electronics add-ons (innovator. samsungmobile.com)

Description
Android Repository

iﬁddAd(Lonfilie;} Delete Add-on Site | [¥] Display update: E’eﬂ nstall Selected

Slika 2.1 Android AVD and SDK Manager

Preuzimamo potrebne komponente za razvoj Android aplikacija pomocu korisnickog
sucelja (Slika 2.1). Komponente preuzimamo iz Android repozitorija koji nudi sljedece

skupine komponenata:

e SDK alati - sluze za uklanjanje pogresaka i testiranje aplikacije


https://dl-ssl.google.com/android/eclipse

o SDK platformski alati - sadrze platformski ovisne alate za razvijanje aplikacije
e Android platforme

e USB drivere za Windows-e

e Primjeri - primjeri aplikacija za svaku Android razvojnu platformu

e Dokumenatcija - lokalna kopija posljednje dokumentacija za Android API (engl.
Application Programming Interface)

Uz navedene komponente i alate moguce je preuzeti Third party Add-ons koji omogucuju
razvijanje okruzenja za specifi¢cnu Android vanjsku biblioteku. Primjer takvih dodataka je
Google Maps biblioteka.

Android SDK and AVD Manager nudi opciju stvaranja emulatora za testiranje aplikacija na
virtualnom uredaju - AVD (Slika 2.2). Izbornik nudi moguénost izbora i proizvoljnog

odabira razli¢itih hardware i software performansi koje ¢e biti emulirane.
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Slika 2.2 Android emulator




2.3. Stvaranje projekta

U ovom potpoglavlju objasniti ¢e se stvaranje temeljnog Android projekta i njegovu
strukturu. Podrazumijeva se instalacija Eclipse-a i preuzimanje potrebnih paketa za ravoj
Android aplikacija (ADT i SDK) i stvaranje vlastitog AVD-a.

Sljedeci korak stvaranje novog Android projekta na sljede¢i na¢in: File > New > Project >
Android Project. Pojavljuje se izbornik u kojem postavljamo osnovne postavke projekta
(Slika 2.3).

= Mew Android Project l E] |

New Android Project

Creates a new Android Project resource,

Project name:  HelleAndroid

Contents

(@ Create new project in workspace
(7 Create project from existing source
[¥] Use default location

C:/Users/smain/workspace/HelloAndroid Browse...
(7 Create project from existing sample

Samples: | This target has no samples. Please select another target.

Build Target
Target Name Vendor Platform APL..
[] Android1.5 Android Open Source Project 1.5 3
[[] Android 1.6 Android Open Source Project 1.6 4
Android 21-u... Android Open Source Project 21-up.. 7
[] Android 2.2 Android Open Source Project 2.2 g
[] Android 2.3 Android Open Source Project 2.3 9

Standard Andreid platform 2.1-updatel

Properties

Application name:  Hello, Andreid

Package name: com.examplehelloandroid

Create Activity:  HelloAndroid

Min 5DK Version: 7

@ [ <Back || nea> |[ Enish || canca |

Slika 2.3 Izbornik novog Android projekta



Potrebno je ispuniti sljedeéa polja:

2.4.

Project Name - ime direktorija u kojem se nalaze projektne datoteke
Application Name - ime aplikacije koje ¢e se prikazati na Android uredaju

Package Name - ime paketa pod kojim ¢e se nalaziti sav potreban kod. Ime paketa

mora biti jedinstveno, takoder preporucljiva je dosljednost pri nazivanju paketa

Create Activity - ime klase koja ¢e se automatski stvoriti. Ona ¢e biti podklasa klase
Activity. Klasa Activity omogucuje rad aplikacije, moze stvarati korisni¢ko
sucelje ili obavljati odreden zadatak. Aplikacija moze sadrzati vise takvih klasa, ali

se njima pristupa odvojeno

Min SDK Version - vrijednost koja odreduje minimalni nivo API-a potreban za

koristenje aplikacije

Build Target - izbor platforme kompajliranja. Potrebno je imati uredaj jednake ili

naprednije platforme; u protivnom, aplikaciju nece biti moguée pokrenuti

Struktura aplikacije

Nakon popunjavanja polja prema navedenim uputama (Slika 2.3), automatski se generiran

kostur Android aplikacije. Android aplikacija je strukturirana u stablo direktorija. Struktura

Android aplikacije je specificna i potrebno ju je dobro prouciti. Unutar samog projekta

nalazi se viSe datoteka i direktorija:

AndroidManifest.xml - xml datoteka koja opisuje aplikaciju koja se pokrece i koje

komponente koristi aplikacija
build.xml - Ant skripta za kompajliranje i instaliarnje aplikacije

assets/: - direktorij koji sadrzi staticke datoteke koje Zelimo uz prenjeti uz

aplikaciju
gen/: - sadrzi automatski generirane datoteke
src/: - sadrzi Java source kodove

res/: - sadrzi ikone, definicije grafickih korisni¢kih sucelja i XML datoteke

U zadanom primjeru unutar src/: direktorija nalazi se datoteka HelloAndroid.java koja

sadrzi aktivnost HelloAndroid te metodu onCreate () Koja se poziv pokretanjem



aktivnosti. Aktivnosti su javne klase koje nasljeduju osobine od android.app.Activity
klase. Metoda onCreate () u sebi sadrzi inicijalizaciju i definiranje korisni¢kog sucelja,
dok import linije sadrze sve klase koje se namjeravaju referencirati.

package com.example.helloandroid;

import android.app.Activity;

import android.os.Bundle;

public class HelloAndroid extends Activity {
@Override
public void onCreate (Bundle savedInstanceState) {
super.onCreate (savedInstanceState) ;

setContentView (R.layout.main) ;

Kod 2.1 Automatski generirana aktivnost

Komunikaciju korisnika s mobilnom aplikacijom omogucuje GUI (engl. Graphic User
Interface). Korisni¢ko suéelje Android aplikacija sastoji se u vecini slu¢ajeva od razli¢itih
elemenata korisni¢kog sucelja (widget). Widget je objekt preko kojeg korisnik komunicira
s aplikacijom; to su na primjer tipke, polja, labele ili padajuéi izbornici. Specifi¢nost
programiranja Android aplikacija je u tome, S$to je moguce uz stvaranja grafickog
korisnickog sucelja putem Java koda, stvaranje korisnickog sucelja pomocu XML
datoteka.

Dinamicko instanciranje widget-a je rezervirano za kompliciranije scenarije kada nije

unaprijed poznat izgled sucelja, vec¢ je izgled uvjetovan ulaznim parametrima.

2.5. Struktura XML datoteke

Definiranje korisnickog sucelja pomo¢u XML datoteka izrazito je korisno iz viSe razloga:
jednostavnost, hijerarhijska struktura, promjenjivost, povezanost podelemenata sucelja i
nepodloznost promjenama izvornog koda. Referenciranje elemenata korisnickog sucelja
(widget) u Java kodu preko jedinstvenog android:id atributa omogucava jednostavno
programiranje funkcija sucelja. Zbog navedenih razloga XML postaje sve koriSteniji u

definiciji grafi¢kog korisnickog sucelja.



Na vrhu XML datoteke odreduje se tip prikaza. Tip prikaza naziva se layout, on name sluzi

grupiranju vise podelemenata korisnickog sucelja u cijelinu. Tip prikaza sugerira u kakvom

su odnosu objekti djeca (Tabela 2.1). Klase tipa Layout su podklase klase ViewGroup.

Klasa Opis

FrameLayout Okvir koji se ponaSa kao jedinstven objekt

Gridview Prikazuje mreZu s M redova i N stupaca

Gallery Horizontalni pomicini prikaz slika

LinearLayout Organizira djecu u jedan red ili stupac

ListView Prikazuje pomi¢nu listu s jednim redom

Relativelayout | Omogucava postavljanje relativnog odnosa medu objektima djecom i
roditeljima

ScrollView Vertikalni pomi¢ni niz elemenata

Spinner Prikazuje jedan izabrani element liste u predefiniranom prostoru

SurfaceView Omogucuje direktan pristup prostoru za crtanje

TabHost Tabli¢ni izbor koji omogucuje promjenu prozora pri pritisku

TableLayout Izgraduje tablicu s proizvoljnim brojem redova i stupaca; untar svake
¢elije se nalazi zaseban widget

ViewFlipper Lista koja prikazuje jedan po jedan element u odredenim intervalima

Tabela 2.1 Vrste prikaza

Unutar layouta se nalaze elementi korisnickog sucelja (widget) koji su podklase View.

Takvnih elemenata ima mnogo te sluze za ispunjavanje razli¢itih zadataka ovisno o

zahtjevima. Sve vrste elemenata korisnickog sucelja sadrze temeljne atribute kao $to su:

e android:id

e android:layout width / android:layout height

e android:text




Osim navedenih temeljnih atributa svaka klasa elemenata ima zasebne specifi¢ne atribute
ili funkcionalnosti te se iz tog razloga razli¢iti elementi korisnickog sucelja koriste za
izvr$enje razliCitih zadaca. Specifi¢ne funkcionalnosti se definiraju preko XML datoteke, a
njihova funkcija im se pridodaje unutar glavnog programa (Activity), ako postoji, ili

klase koja generira korisnicko sucelje.

U nastavku su opisani od autora izdvojeni elementi korisnickog sucelja s opisom i

specifi¢nim atributima i metodama (Tabela 2.2).

Element korisnickog sucelja Opis, specificne metode ili atributi

EditText Nasljeduje TextView; promjenjivo polje
string getText ()
void setText ()

void selectAll ()

Button 11pka

android:onClick

CheckBox Okvir za izbor

void setChecked ()

boolean isChecked()

Scroller Omogucuje klize¢i prijelaz

RadioButton Gumb s dva stanja; sklopka

void toggle ()

PopupMenu Implementira iskac¢u¢i izbornik
NumberPicker Omogucuje korisniku izbor brojeva unutar predefiniranog
raspona

void setMaxValue (int )
void setMinValue (int )

void setValue (int )

Tabela 2.2 Elementi grafi¢kog korisni¢kog sucelja




Specifini¢nost izrade android aplikacije lezi u automatskom generiranju R.java datoteke.
Unutar navedene datoteke se nalaze staticke vrijednosti koje jednoznac¢no referenciraju
objekte koje smo stvorili. Time se znatno olakSava pristupanje pojedinom objektu.
Uredivanje R.java datoteke od strane korisnika je moguce, ali nije preporucljivo. Stati¢ke

vrijednosti su tipa final int te su zapisane u heksadekatskom formatu.
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3. Teorija izvedbe

Kao $to je navedeno u uvodu temeljna zamisao ovog rada je razviti novu napredniju
virtualnu tipkovnicu osjetljivu na dodir za mobilne uredaje s Android operacijskim
sustavom. To ¢e se ostvariti oponaSanjem veé postojece tipkovnice za mobilne uredaje s
Android operacijskim sustavom (Slika 3.1) uz izgled i funkcionalnost tipkovnica kakve su

se koristile na starim mobilnim uredajima (Slika 3.2).

12:05 PM
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Slika 3.1 Standardna Android tzv. "qwerty" tipkovnica

Ulazni zahtjevi ovog projekta su da korisnik moze u bilo kojem trenutku birati izmedu
standardne tipkovnice i tipkovnice koja ¢e biti razvijena. Takoder korisniku je potrebno
omoguciti odredene funkcionalnosti koje postoje na Android tipkovnici, a stariji mobilni
uredaji ih nemaju. Na primjer: mogucnost sakrivanja tipkovnice, prelazak iz pisanja teksta

u pisanje simbola i brojeva.
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Slika 3.2 Primjer starog mobilnog uredaja s tipkovnicom

Pogledom na stari mobilni uredaj (Slika 3.2), vidimo da je potrebno sacuvati temeljnih 12
tipki kao Sto su postojale na starim mobilnim uredajima s ocuvanim rasporedom.
Implementacija poCetne aplikacije koja ¢e jednako oponasati staru tipkovnicu je pocetni
zadatak koji ¢e se izvrSiti U svrhu upoznavanja i razumijevanja programiranja Android
aplikacija. Nakon toga ¢e se krenuti u stvaranje upotrebljive numericke virtualne

tipkovnice pod Android operacijskim sustavom.

3.1. Pokazna aplikacija

Dijagram toka navedene aplikacije dan je na sljedecoj stranici dokumenta (Slika 3.3).
Ovisno o pritisku odredene tipke potrebno je ispisati trazeno slovo, znak ili broj. Takoder
potrebno je nadzirat frekvenciju uzastopnog pritiska iste tipke, kao $to je to na starijim
mobilnim uredajima. Navedena aplikacija nece biti u mogucnosti koristiti se kao stvarna
tipkovnica na mobilnim uredajim s Android operacijskim sustavnom, niti nece biti u stanju

napisani tekst i simbole prosljedivati dalje.

12



Eoja tipka je
prtisnuta®

zlazr = charTipke

izlaz ++

Slika 3.3 Dijagram toka demo aplikacije
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3.1.1. Definicija korisnickog su€elja pomoc¢u XML datoteke

Za pocetak potrebno je implementirati GUI koji oponasa tipkovnicu na starijm mobilnim

aparatima. Definiciju GUI-a izvrsiti ¢emo uredivanjem XML datoteke. Vrsta odnosa

izmedu elemenata GUI-a demo aplikacije biti ¢e postavljen kao RelativeLayout.

Definiranjem ovog odnosa olak$ana je manipulacija polozaja elemenata GUI-a u

medusobnom odnosu. Zatim je potrebno odrediti koliko elemenata grafickog korisnickog

sucelja aplikacija zahtijeva. U svrhu ove aplikacije koristit cemo 13 widgeta; dvanaest tipki

I jedno promjenjivo polje koje sadrzi tekst. Definicija navedenih elemenata GUI-a i

njihovih specifi¢nih atributa navedeni su u nastavku (Tabela 3.1).

Element GUI-a Atributi
TextView android:id="@+id/tekstbox"
android:layout width="fill parent"
android:layout height="75px"
android:text=""
android:textSize="18sp"

android

android:

android:

android:

:layout below="@+id/lejaut"

layout alignParentLeft="true"
singleLine="false"

autoText="true"

Button (1..12)

android:

android:

android:

android:

android:

android:

android:

android:

android:

id

layout width="110px"
layout height="85px"
padding="10px"

text

layout below

layout alignParentLeft
layout toRightOf

onClick

Tabela 3.1 Koristeni elemetni GUI-a
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Promjenjivo polje za prikaz teksta je samo jedno te su navedeni svi njezini potrebni
atributi. Atribut android:text definira inicijalno stanje teksta koji se nalazi u polju.
Definirano je da je polje pri pokretanju aplikacije prazno kako bi se moglo omoguciti
pisanje iz pocetka pri svakom pokretanju aplikacije. Atribut android:singleLine
odreduje moguénost pisanja unutar vise redova. Pozeljno je da se iskljuci ova opcija. Ostali

atributi nam sluze za pozicioniranje polja unutar prikaza, njegove dimenzije te font ispisa.
Sve tipke kao elementi sucelja sadrze tri indenti¢na atributa, a to su:

e android:padding

e android:layout height

e android:layout width

Oni su jedaki za sve tipke jer su o¢ito svi istih dimenzija te je razmak medu njima jednolik.
Vidljivo je da se nalaze mnogi atributi za pozicioniranje tipki u relativnom odnosu, $to
nam omogucéuje RelativelLayout te android:id koji nam jednozna¢no odreduje
svaku tipku. Atribut android:text odreduje s kojim ¢e tekstom biti ispunjen tipka, sto
nam sluzi korisniku za raspoznavanju pojedinih tipki. Atribut android:onClick je
specifian za interaktivne elemente grafiCkog sucelja koju su klase Button. Njime se
definira ime metode koja ¢e biti pozvana pritiskom na tipku. Navedeni atribut je izuzetno
koristan jer nam omogucuje direktno definiranje metode unutar izvornog kéda bez da smo
prije referencirali tipku unutar kdda, ve¢ isklju¢ivo unutar XML datoteke. Istu metodu
mogu pozivati viSe tipki. Implementacija metode biti ¢e objasnjena u sljede¢em
potpoglavlju. Vazno je napomenuti da se metoda onC11ick pojedine tipke moze takoder
definirati iskljucivo iz izvornog kdda, gdje se svakoj tipki pristupa pomocu jedinstvenog
android:id. Time bi se izgubilo na preglednosti koda te bi zanemarili jednu vaznu

blagodat programiraju Android aplikacija u ovom razvojnom okruZenju.

Nakon postavljanja XML datoteke na na¢in koji je opisan; izgradeno je sljedece korisnicko

graficko sucelje (Slika 3.4).
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Slika 3.4 Korisni¢ko sucelje demo aplikacije
3.1.2. Dodjeljivanje funkcije aplikaciji

Nakon definiranja korisnickog sucelja aplikacije potrebno je uvesti funkcionalost
elemetima sucelja. Dodavanje funkcionalnosti aplikacije vr§Simo kroz uredivanje izvornog
koda. Izvorni kod se nalazi unutar src/ direktorija. U pocetku se automatski generira kod
od strane Eclipse-a kao $to je prije navedeno. Uredivanjem navedenog generiranog kdda

pridodaje se funkcionalnost aplikaciji.

Prvo §to je potrebno napraviti je uvesti import linije jer u sluaju da one ne postoje
Eclipse IDE ne moze pronaéi ugradene metode specificne za pojedine elemente

korisni¢kog sucelja. Za ovu aplikaciju potrebno je uvesti sljedece datoteke:
e android.view.View
e android.widget.Button

e android.widget.TextView
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Dodavanje biblioteke za tipke (android.widget.Button) nije potrebno jer smo
metodu onClick za svaku pojedinu tipku definirali unutar XML datoteke, ali
preporuc¢eno je da se doda. Biblioteka za polje s promjenjivim tekstom se dodaje
(android.widget.TextView) jer ¢e se koristiti njezine ugradene metode te ¢e se
ponasati kao varijabla. Deklaracija varijable tipa TextView izvr§ava se na sljede¢i nacin:

TextView polje;

@Override

public void onCreate (Bundle savedInstanceState)
polje=(TextView) findViewById (R.id. tekstbox) ;

Kod 3.1 Deklaracija varijable

Pomoc¢u jedinstvene adrese zapisane unutar R.java datoteke pristupamo pojedinom
elementu kojeg smo definirali unutar XML datoteke. Vazno je primjetiti da je potrebno

izvrsiti cast varijable prije referenciranja elementa sucelja.

Unutar XML datoteke definirane su onC1ick metode, a sad ih je potrebno referencirati i

dodati im funkcionalnost. Za navedenu svrhu izgradene su sljedece funkcije (Tabela 3.2):

Prototip funkcije Opis

public void klik(View) Funkcija kao wulazni parametar dobiva korisnicko

sucelje; ovakvih funkcija ima koliko i tipki (12); jedina
razlika izmedu njih je char koji stvaraju i prosljeduju

funkciji applyFormat

private void applyFormat (char)

Funkcija kao ulazni parametar dobiva varijablu tipa
char te ju spaja s ve¢ postoje¢im tekstom, a zatim ga

ispisuje na prikaz pomocu ugradene metode setText

public final wvoid

polje.setText (CharSequence)

Ugradena metoda specificina za prikaz tipa
TextView; kao ulazni parametar dobiva varijablu

tipa string ili char te ju ispisuje unutar prikaza

Tabela 3.2 Metode za dodavanje funkcionalnosti

Nakon definicije funkcije pojedinih tipki javlja se problem detekcije visestrukog pritiska

iste tipke unutar zadanog vremenskog intervala. Unutar aplikacije potrebno je izvrsiti
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dohvat vremena i brojanje frekvencije uzastopnog pritiska iste tipke. To se izvodi
dohvatom sistemskog vremena nakon pojedinog pritiska tipke te ga nakon sljedeceg
uzastopnog pritiska iste tipke umanjuje za novo sistemsko vrijeme, ako se vremenski
interval dva uzastopna pritiska nalazi unutar 1 sekunde potrebno je ispisati sljedece slovo u
nizu. Dohvat programskog vremena vr$i se pomoc¢u ugradene metode
currentTimeMillis. Navedena metoda nalazi se unutar  biblioteke

java.lang.System.

Navedena funkcionalnost se nefe implementirati unutar aplikacije zbog nedostatka
vremena. Uz to ovo je samo demo aplikacija koja moZe pomoc¢i Citatelju daljni razvoj 1
nadogradnju aplikacije. Implementacija stvarne funkcionalne virtualne tipkovnice biti ¢e

obradena u sljedec¢em poglavlju.
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4. Programska izvedba virtualne tipkovnice

Koristenjem ugradene klase KeyboardView =znatno je olakSana implementacija
tipkovnice za Android operacijski sustav. Metode koje koristi navedena klasa su specifi¢ne

za nju te ¢e njihova upotreba i funkcija biti objasnjena u daljnjim poglavljima.

4.1. Definicija korisnickog sucelja

Definicija grafickog korisni€¢kog sucelja biti ¢e izvrSena pomoc¢u XML datoteka. Klasa
KeyboardView ima specifian nain oblikovanja grafickog korisni¢kog sucelja. Sucelje

se dijeli hijearhijski u stablo (Slika 4.1).

Tipkovnica

Red #1 Red #2 Red #3

Tipka #1 Tipka #2 Tipka #3

Slika 4.1 Hijerarhijska struktura tipkovnice

Takoder na takav naéin se izgraduje XML datoteka. Tipkovnica sadrzi atribute Koji
definiraju veli¢inu svih tipki, poloZaj tipkovnice i razmak medu tipkama. Tipke sadrze
atribute koji kasnije sluze za dodavanje funkcije pojedine tipke, dimenzije tipke te njihov

oblik prikaza (slika ili znakovi). Primjer deklaracije tipkovnice prikazan je kodom 4.1.
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<Keyboard xmlns:android
android:keyWidth
android:horizontalGap
android:verticalGap
android:keyHeight

>

<Row>
<Key android:codes
android:keyLabel
android:keyWidth
android:keyEdgeFlags
android:keyIcon
android:isRepeatable/>

<Key

/>

</Row>
Koéd 4.1 Primjer definicije jednog reda tipkovnice s prilozenim atributima
Atributi koji opisuju pojedinu tipku i njihov opis su sljede¢i:

e android:codes - navodimo koji ¢e se znak prema ASCII tablici generirati
pritiskom; navedena funkcija ¢e biti programirana u izvornom kodu; odvajanjem

vise znakova dodjeljuje se funkcionalnost uzastopnog pritiska tipke (multitap)
e android:keyLabel -ime prikaza

e android:keyWidth; android:keyHeight - dimenzije tipke; standardne
vrijednosti deklarirane su prilikom definiranja cijele tipkovnice, a unutar same

tipke se dodaju iznimke
e android:keyIcon - slika prikaza, ako postoji

e android:isRepeatable - moguénost ponavljanja
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Voden ulaznim zahtjevima izradena je tipkovnica sa sljede¢im tipkama (Tabela 4.1).

Naziv tipke Funkcija i opis
1., Sluzi za unos interpunkcijskih znakova i brojke jedan
Redoslijed znakova: ., ?!:;1
2 abc Redoslijed znakova: ab c 2
3 def Redoslijed znakova: d e f 3
4 ghi Redoslijed znakova: g hi 4
5 jkI Redoslijed znakova: j k15
6 mno Redoslijed znakova: mno 6
7 pars Redoslijed znakova: pqrs7
8 tuv Redoslijed znakova: tuv 8
9 wxyz Redoslijed znakova: wxy z 9
* Redoslijed znakova: *+-_()=""
0 Redoslijed znakova: razmak 0
# Redoslijed znakova: # & / % $
DEL Brise
SHIFT Omogucuje ispis velikih slova ili alternativnu funkciju tipke
SYM Tipka koja otvara simboli¢ku tipkovnicu standardnog Android uredaja
CLOSE Tipka koja sluzi za sakrivanje tipkovnice nakon prestanka upotrebe

Tabela 4.1 Funkcije i opis tipKi
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Emulirana je virtualna numeri¢ka tipkovnica koja sadrzi pojedine funkcionalnosti
standardne Android tipkovnice. Definicijom XML datoteke nije definirana funkcija

pojedinih tipki ve¢ njezin fizicki izgled i temelj za pridodavanje stvarne funkcionalnosti.

4.2. Implementacija klasa

4.2.1. Klasa LatinKeyboard

Navedena klasa sluzi za stvaranje tipkovnice. Klasa je deklarirana na sljede¢i nacin
(Tabela 4.2):

public class LatinKeyboard extends Keyboard

konstruktor | public LatinKeyboard(Context context, int
layoutTemplateResId, CharSequence characters, int columns,

int horizontalPadding)
{

super (context, layoutTemplateResId, characters, columns,

horizontalPadding) ;
}
varijable private Key mEnterKey
pnﬁoﬂp void setImeOptions (Resources res, int options)

funkcije

protected Key createKeyFromXml (Resources res, Row parent, int

x, int y, XmlResourceParser parser)

Tabela 4.2 Klasa LatinKeyboard

Funkcija setTmeOptions nam sluzi da postavi odgovarajucu vidljivu labelu pri pritisku

tipke ako postoji.

Funkcija createKeyFromXml stvara tipku na temelju podataka dohvacenih iz

odgovaraju¢e XML datoteke.
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Unutar klase nalazi se takoder deklaracija klase Key (Tabela 4.3).

static class LatinKey extends Keyboard.Key

konstruktor | public LatinKey (Resources res, Keyboard.Row parent, int x,

int y, XmlResourceParser parser)
{
super (res, parent, x, y, parser);

}

prototip public boolean isInside (int x, int y)

funkcije

Tabela 4.3 Klasa Key
Implementacija ove klase omogucuje deklariraciju razli¢itih tipkovnica, ovisno o XML
datoteci, koje ¢e biti dostupne korisniku.

4.2.2. KlasaLatinKeyboardView

Klasa je preuzeta iz primjera. Nasljeduje klasu Keyboardview. Klasa sluzi za dodavanje
dodatnih opcija korisniCkom sucelju. Procesira se kao posebna tipka (delete, shift ili enter).
Deklaracija klase i njezina funkcija nalazi se u nastavku (Tabela 4.4).

public class LatinKeyboardView extends KeyboardView

konstruktor | public LatinKeyboardView (Context context, AttributeSet attrs,
int defStyle)

{
super (context, attrs, defStyle);

}

pﬂﬁOﬂp protected boolean onLongPress (Key key)

funkcije

Tabela 4.4 Klasa LatinKeyboardView
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4.2.3. Klasa VirtualKeyboard

Klasa VirtualKeyboard dodaje funkciju tipkovnici te se sluzi prethodno navedenim
klasama kao varijablama. Navedena klasa sluzi se specifiénim funkcijama koje se nalaze u
biblioteci klase od koje nasljeduje svojstva. Takoder implementirane su pomo¢ne funkcije

koje nam sluze za jednostavnije upravljanje zadace tipkovnice.

4.2.3.1 Varijable

Koriste se sljedece varijable:
e private long mLastShiftTime
e private KeyboardView mInputView
e private StringBuilder mComposing
e private int mLastDisplayWidth
e private boolean mCapsLock
e private LatinKeyboard mSymbolsKeyboard
e private LatinKeyboard mSymbolsShiftedKeyboard
e private LatinKeyboard mQwertyKeyboard
e private LatinKeyboard mQwertyOldKeyboard
e private LatinKeyboard mCurKeyboard
e private long mLastShiftTime
e private long mMetaState
e private long mMetaState

e private String mWordSeparators

Varijable tipa LatinKeyboard sluze da u njima spremamo podatke o stvorenim
tipkovnicama unutar XML datoteka ili referenciramo tip postojeée tipkovnice. Varijabla
mInputView  sluzi za stvaranje izabrane tipkovnice pomocu  funkcije
mInputView.setKeyboard (). Varijabla mMetaState pokazuje koje su funkcijske
tipke pritisnute, ako postoje. Ostale varijable nalaze se kao pomoc¢ne varijable unutar

metoda.
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4.2.3.2 Metode i funkcije

Klasa je deklarariana na sljede¢i nacin (Tabela 4.5).

public class VirtualKeyboard

KeyboardView.OnKeyboardActionListener

extends

InputMethodService implements

Tabela 4.5 Deklaracija klase

Tabela 4.6 prikazuje popis metoda i funkcija za inicijalizaciju klase VirtualKeyboard.

Prototip funkcije

Opis

public void onCreate ()

Prilikom stvaranja dohvac¢a podatke o

separatorima  (interpunkcijski  znakovi,

razmak itd.)

public void onInitializeInterface()

Incijalizacija korisnickog sucelja; dohvaca
podatke o definiranim tipkovnicama unutar
XML datoteke 1 pridjeljuje ih odredenim

varijablama

public View onCreatelInputView ()

Funkcija koja emulira tipkovnicu iz podataka

definiranih unutar funkcije

public void onStartInput (EditorInfo

attribute, boolean restarting)

Incijalizacija na¢ina unosa u ovisnosti o tipu

tesksta koji zelimo unjeti

public void onFinishInput ()

Nakon zavrSenog unosa tipkovnica se

sakriva i postavlja u incijalno stanje

public void onStartInputView (EditorInfo

attribute, boolean restarting)

Omogucuje ¢uvanje stanja tipkovnice nakon

zatvaranja

private boolean translateKeyDown (int

keyCode, KeyEvent event)

Omogucuje procesiranje posebnih funkcija i

tumaci pritisak tipke

public boolean onKeyDown (int keyCode,

KeyEvent event)

Nakon pritiska funkcija odabire akciju koju

¢e napraviti ovisno o pritisnutoj tipci

Tabela 4.6 Metode klase VirtualKeyboard - incijalizacija
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Takoder implementirano je mnogo pomo¢nih funkcija koje nam pomazu da procesiramo

sve zadace tipkovnice (Tabela 4.7).

Prototip funkcije

Opis

private void commitTyped (InputConnection

inputConnection)

Pomo¢na funkcija koja sluzi za pisanje

znakova

private void

updateShiftKeyState (EditorInfo attr)

Osvjezava stanje SHIFT tipke ovisno o

tipkovnici

private boolean isAlphabet (int code)

Provjera znaka da li je uneseno slovo

private void keyDownUp (int keyEventCode)

Funkcija uzrokuje prikaz pritisnute tipke

private void sendKey (int keyCode)

Procesiranje znaka; pomoc¢na funkcija

public void onKey (int primaryCode, int[]

keyCodes)

Implementacija
KeyboardViewListener

unutar sebe poziva razne podfunkcije

public void onText (CharSequence text)

Procesiranje pritiska ako je unesen tekst

private void handleBackspace ()

Pomo¢na funkcija implementirana da

emulira tipku DEL

private void handleShift ()

Pomoc¢na funkcija postavlja stanje tipke
SHIFT na pritisak

private void handleCharacter (int

primaryCode, int[] keyCodes)

Funkcija koja obraduje pritisnut znak te

ga priprema za ispis

private void handleClose ()

Pomoéna funkcija procesira posebnu

tipku za sakrivanje tipkovnice

private void checkToggleCapsLock ()

Funkcija osvjezava stanje tipke SHIFT

private String getWordSeparators ()

Dohvaca separatore iz values/string

public boolean isWordSeparator (int code)

Provjera da li je pritisnut znak separator

Tabela 4.7 Metode klase VirtualKeyboard - pomocne funkcije i ispis
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Posebnu paznju pridaje se metodama koje se nalaze u biblioteci tipkovnice i specifi¢ne su

za navedenu Klasu (Tabela 4.8). Neke metode nisu implementirane zbog moguénosti

zbunjivanja korisnika, $to bi uvelike umanjilo funkcionalnost tipkovnice.

Prototip ugradene metode

Opis zadace

public void

swipeleft ()

Preusmjerava se na tipku DEL

public void

swipeRight ()

Omogucuje  brzu izmjenu izmedu
razvijene  tipkovnice i  standardne

"qwerty" tipkovnice

public void

swipeUp ()

Zadacée ove funkcije nije implementirana

zbog prakti¢nosti

public void

swipeDown ()

Zatvara tipkovnicu

public void

onRelease (int primaryCode)

Zadacée ove funkcije nije implementirana

zbog prakti¢nosti

public void

onPress (int primaryCode)

Zadace ove funkcije nije implementirana

zbog prakti¢nosti

Tabela 4.8 Metode klase VirtualKeyboard - specifi¢ne ugradene metode
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4.3. lzlazni proizvod

Implementacijom XML datoteke, prikaza, metoda i funkcija iz prethodnih poglavlja te
definiranjem njihovih zadaca stvoren je konacni proizvod. Tipkovnica se ukljucuje za

koristenje izbornikom Settings (Slika 4.2).

1! Ml 11:06 AM

ANUTNOId keyuudid

@ Accounts & sync

Android keyboard

HH Privacy Japanese IME

@ 5D card & phone storage

Japanese IME

Q, Search

Language & keyboard

¥ Accessibility

NumVirtTipkovnica
Device keyboard

User dictionary

Slika 4.2 Izbor tipkovnice

Nakon ukljucivanje tipkovnice ona je spremna za koristenje. Prilikom korisStenja virtualna
numericka tipkovnica uspje$no emulira stare tipkovnice uz dodatke modernih tipkovnica
(Slika 4.3). Uz navedenu tipkovnicu moguce je pristupiti i standardnoj "qwerty" tipkovnici
potezom prsta u desno po tipkovnici, a povratak na emuliranu tipkovnicu se odvija na
jednak nacin. Tipka SYM omogucuje prijelaz u simboli¢ku tipkovnicu kakva postoji na

standardnim mobilnim uredajima s Android operacijskim sustavom (Slika 4.4).

Uspjes$no je izvrSen zadatak zadan ulaznim zahtjevima. Krajnji proizvod nalazi se u
privitku ovog rada na CD-u, zajedno s razvojnim okruzenjem, potrebnim dodacima i
literaturom.
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Ml & 11:06 PM

Boro

Nemrem na kavu pisem
zavrsni. :(

[l 2abc = 3def &
4 ghi 5iki  6mno £

7pgrs 8tuv  9wxyz sym

* 0 #

w

Slika 4.3 Numericka virtualna tipkovnica

M€ 11:10PMm

21 13114115 Te 7] 18119110

@ # $ % & *

Slika 4.4 Simbolicka tipkovnica
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5. Diskusija

Razvijen proizvod uspio je ispuniti ulazne zahtjeve ovog rada, ali uvijek postoji prostor za
poboljsanje. Pravu ocjenu aplikacije moze dati jedino grupa korisnika nakon testiranja te
detaljna analiza njihovih zahtjeva i zamjerki.

Mogucénost prijelaza iz numericke virtualne tipkovnice u standardnu "qwerty" tipkovnicu u
bilo kojem trenutku jednostavnim pokretom po ekranu osjetljivom na dodir znacajno
poboljsava funkcionalnost tipkovnice. Korisnik moZe izabrati nacin koristenja tipkovnice
ovisno da li se nalazi u pokretu, kada je preporucljivo koristiti numericku tipkovnicu zbog

preciznosti, ili kada se ne krece, kada moze koristiti standardnu tipkovnicu.

Najveci nedostatak virtualne numericke tipkovnice su funkcionalnosti tipki ***** i ""#"". Kod
starith mobilnih uredaja navedene tipke su stvarale posebne znakove ili su bile u funkcije
tipke SHIFT. Na numerickoj virtualnoj tipkovnici one sluze za unos posebnih znakova, ali
je problem Sto korisnik ne moze unaprijed znati koji znak upisuje te koji slijedi. Ovaj
problem bi se mogao rijesiti implementacijom navedene funkcije unutar keyDownUp
metode, ali se tada javlja problem preglednosti. Mogucée rjeSenje ovog problema je
uklanjanje navedenih tipki i postavljanje dodatnih tipki za prijelaze u razli¢ite simbolicke

tipkovnice.

Polozaj tipke SPACE koje se provlacilo godinama kod proizvodaca mobilnih uredaja
takoder je postavljao dilemu. Odluceno je da se ona nalazi unutar tipke "0" kao Sto je to

bilo na starijim Nokia mobilnim uredajima, to¢nije Nokia 3310 modelima.

Funkcionalnosti modernih tipkovnica numericke virtualne tipkovnice sadrzani su u
Cetvrtom stupcu tipkovnice (Slika 4.3). Ovakvom implementacijom korisni¢kog sucelja
korisnik nece ostati zakinut za sve blagodati koje nude moderne tipkovnice uredaja s

Android operacijskim sustavom.

Uz pomo¢ implementacije virtualne tipkovnice dane ovim radom moguce su jednostavne

preinake i nadogradnje prema $to funkcionalnijoj i korisniku ugodnijoj tipkovnici.
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Zakljuéak

U okviru zavr§nog rada ostvarena je virtualna numericka tipkovnica za uredaje s Android
operacijskim sustavom prilagodena ulaznim zahtjevima. Aplikacije je stovrena pomocu
Eclipse razvojnog okruzenja uz pomo¢ posebnih alata za razvoj Android aplikacija.
Kona¢ni izlazni proizvod rada je kriptirana datoteka koji sluzi za pokretanje navedene

aplikacije na uredaju s Android operacijskim sustavom.

Tijekom razvoja aplikacije usvojena su vrijedna znanja objektno orijentiranog
programiranja, razvoja Android aplikacija i koriStenja razli¢itih programskih alata. Zadatak
je bio intrigantan, ali zahtijevan. Koristenje primjera i razne literature uvelike su pomogli u

razumijevanju danog zadatka i njegovom izvrSenju.

Citatelju ovog rada dan je uvod u programiranje Android aplikacije i navedeni su svi
potrebni alati za razvoj navedenih aplikacija. Na temelju postoje¢e aplikacije, numericke
virtualne tipkovnice, ¢itatelj ovog rada moze lako izgraditi svoju vlastitu virtualnu
tipkovnicu za uredaje s Android operacijskim sustavom. Moguce su preinake na postojecoj
tipkovnici, ovisno o zahtjevima te dodavanje novih funkcionalnosti i nadogradnje na

postojecem kosturu.

Na CD-u koji prilazem kao privitka uz ovaj zavrsni rad nalaze se sljede¢e datoteke i
direktoriji: direktorij s kona¢nom aplikacijom, Eclipse razvojni sustav verzija 3.6 (Helios),

Android SDK alati, literatura, prezenatacija i dokument zavr$nog rada.
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Skracenice

IDE

ADT

SDK

AVD

GUI

LCD

USB

XML

IME

engl.
engl.
engl.
engl.
engl.
engl.
engl.
engl.

engl.

Integrated Development Environment integrirano razvojno okruzenje

Android Development Tools
Software Development Kit
Android Virtual Device
Graphic User Interface
Liquid Crystal Display
Universal Serial Bus
Extensible Markup Language

Input Method Editor

Android alati za razvoj

alati za razvoj programske podrske
virtualni emulator Android uredaja
korisnicko graficko sucelje

prikaz teku¢im kristalima
univerzalna serijska sabirnica
jezik s dodatnim oznacavanjem

stvaratelj nacina unosa
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Sazetak

Numericka virtualna tipkovnica pod Android
operacijskim sustavom

U ovom radu opisan je postupak instalacije i postavljanja svih potrebnih alata za razvoj
mobilnih aplikacija za mobilne uredaje koji koriste Android operacijski sustav. Objasnjeni
su temeljni dijelovi Android aplikacija te njihova funkcija. Korisnik pomoc¢u ovog rada i

predloZene literature moze lagano zapoceti s razvojem vlastitih Android aplikacija.

Glavna tema rada je razvoj numericke virtualne tipkovnice pod Android operacijskim
sustavom. Temeljni ulazni zahtjevi su funkcionalnost i jednostavnost. Razvijena tipkovnica
omogucuje korisniku jednostavniju upotrebu tipkovnice na mobilnom uredaju s Android
operacijskim sustavom. Tipkovnica udruzuje funkcionalnost tipkovnica starijih mobilnih

uredaja i novih "qwerty" tipkovnica

Unutar ovog dokumenta opisan je proces dizajniranja virtualne tipkovnice prema zadanim

zahtjevima.

Kljuéne rije¢i: Virtualna tipkovnica, Android operacijski sustav, virtualni emulator,

razvojno sucelje, graficko korisni¢ko sucelje, mobilna aplikacija, mobilni uredaj
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Summary

Virtual numeric keyboard developed for Android
operating system

In this project we describe the process of installing and setting up all the necessary tools to
develop mobile applications for mobile devices using the Android operating system. It
explains the fundamental parts of Android applications and their functions. The reader of
this document can easily start to develop their own Android applications, with the help of

the suggested literature.

The main theme of document is the development of a virtual numeric keyboard developed
under the Android operating system. The basic entry requirements are functionality and
simplicity. This developed keyboard allows the user to easily use the keyboard on their
mobile device which uses an Android operating system. The keyboard combines the

functionality of the old mobile devices keyboards and new "qwerty" keyboards.

This document describes the process of virtual keyboard development suited to match

specific user demands.

Key words: Virtual keyboard, Android operating system, virtual emulator, development

interface, graphical user interface, mobile application, mobile device
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